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1. Installation and Registration

1.1 Installation on Windows

The start screen for the installation will normally be automatically dis-
played. If the auto-start function of your CD/ DVD drive is deactivated,
open the start screen manually by going to My Computer, double clicking
on the CD/DVD drive symbol and then Starter.exe or Starter.

FRANZIS www.projects-software.com Copyright

Once you are at the CD start screen click on ANALOG projects 3 install.
Choose German or English as setup language and follow the installation
assistant’s instructions.

Setup-Sprache auswahl
[A]| wahlen Sie die Sprache aus, die wihrend der

i i‘.‘? Installation benutzt werden soll:

|English - |

[ oK ] [ Abbrechen ]
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Upon starting ANALOG projects 3 for the first time, you will be prompted
to activate the program. Proceed as follows:

Install ANALOG projects 3 as described by the installation wizard.

Input your serial number. For the box version, this can be found on the
accompanying booklet. If you have chosen to download the program, you
will have received the serial number by email directly following your pur-
chase.

2 s o =

30 days remaining.

Serial Mumber: ||

Flease enter your serial number and didk "Activate”,

Finally, click on the “Activate now” button. The software has now been
successfully activated!

Note: ANALOG projects 3 can be installed on up to two computers using
the same serial number.

A second serial number is not necessary. When installing the program on
a second device, simply enter the serial number again and press “Acti-
vate”.

1.2 Installation on Mac

Load your CD into your CD/DVD drive and open the installation menu
through the desktop.

Drag the ANALOG projects 3 file into the program link.
To use the Adobe® Photoshop plug-ins, open the Adobe® Photoshop

plug-ins folder and copy the appropriate plug-ins into your Photoshop
plug-ins folder.
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1.3 Installation of Adobe Photoshop®© Plug-ins

During the installation, you will be asked if you would like to install the
Adobe® Photoshop plug-in.

If you agree to this, you can use DENOISE projects as a plug-in for Ado-
be® Photoshop. Alternatively, the plug-ins can also be manually copied
into the Adobe® Photoshop plug-in folder. Select the plug-in entry folder
in the CD start menu to open it.

Additionally, the latest plug-ins for your software are available at:
http://www.projects-software.com/plugins

1.3.1 Windows 32 Bit Operating Systems

1. Complete the installation of ANALOG projects 3 by activating the
software.

2. For some reasons it may occur that plug-ins cannot be installed auto-
matically in all Adobe Photoshop®© versions. They have to be copied in-
to the plug-ins folder of Adobe Photoshop© manually.

3. Please close Adobe Photoshop®© as well as the stand-alone version of
ANALOG projects 3.

4. Open the installation package folder of ANALOG projects 3. Here, you
will find the plug-ins for all versions of Adobe applications that are
supported.


http://www.projects-software.com/plugins
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—_—
Home Share View ! Search |
@{ ) current folder | I Kind - it
% All subfolders

| =
_D: Size ~ Advanced options = *
Date Open file Close

ﬁ Search again in * | modified = _D Other properties = H Save search location search

Computer

Location Refine Options

T » WINAMALOG projects 3 DE_EN_FR » v & "WIN AM...

F

MName Date modified Type

| Photoshop CC 2014 Plugins 24.02.2015 11:02 Dateiordner
_ Photoshop CC Plugins 24.02.201511:02 Dateiordner
. Photoshop C56 Plugins 24.02.201511:02 Dateiordner
M
b

Photoshop Elements 11 Plugins 24.02.201511:02 Dateiordner
Photoshop Elements 12 Plugins 24.02.2015 1102 Dateicrdner
| Photoshep Elements 13 Plugins 24,02,2015 1102 Dateicrdner
@ WIN AMALOG projects 3_DE_EM_FR_Setup.exe 23.02.2015 1747 Anwendung 170.964 KB

T items

L Computer

5. Open the plug-in folder of your Adobe application (in this instruction
the installation of the plug-in will be demonstrated for Adobe Pho-
toshop© CS6).

Home share View | Search
Ha I 1 P 1
%l[ Ji Current folder 5 Recent searches + ] x
| b !
@I:‘. All subfolders = 5 Advanced options ~ ‘L@

Computer Date Open file Close
ﬁ Search again in ~ | modified = _D Other properties ~ H Save search lacation search

Location Refine Options

T L » WINAMNALOG projects 3_DE_... » Photoshop C56 Plugins v & "WIN AN...

-

Mame Date modified Type

= AMALOGProjects3 PHE x64.8be 11.02.2015 23:32 SBE-Datei
E AMALOGProjects3_PHE_x26.8be 11.02.2015 22:32 3BE-Datei

1M Com puter
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6. Copy the file ANALOGProjects3_PH6_x86.8be from installation
package and paste it into the plug-ins folder of Adobe Photoshop©
CS6 that you will find here:

C:\Program Files\Adobe\Adobe Photoshop CS6\Plug-ins

niEN-|
Home Share View | Search || [ ~ 9

%{ _Is Current folder | % Kind - | 5 Recent searches - ' X '
" [t':_1, All subfolders _D: SEe T Advanced options = '*‘&

Computer —— o Date 0 : . Open file Close
j;} Search again in * | modified~ < Other properties = | In:J Save search location | search :

Location ! Refine ! Options

T . v Adobe » AdobePhotoshop CC2015 ¢ Plug-ins » v & "WIN AM... 2

-

Name Date modified Type

| Athentech 16.06.2015 14:25 Dateiordner
| Generator 16.06.2015 16:29 Dateiordner
. Google 16.06.2015 17:16 Dateiordner
. Imagenomic 16.06.2015 14:25 Dateiordner
| Panels 06.03.2015 13:17 Dateiordner
. Redfield 07.09.2015 12:45 Dateiordner

RN Tl PRI  TH e T Ele R F BEFaWaY | [ m Y il WP W g4 Lo
3 = =

i
A
i
i
A
A

| @ AMALOGProjects3_PHT x64.8be 11.02.2015 22:34 8BE-Datei 821 KB

W I 4= v ang g 4o e Fa T il TP W ol Tl P ]

|=] AutoBye Dermo_64.8bf 10.08.2011 1317 8BF-Datei 745 KB
@ BLACKMWHITEProjects3 PHY_x64.8be 22.05.2014 1539 8BE-Datei 821 KB
E BLACKWHITEProjectsd PHY_x64.8be 23.06.2015 23:01 8BE-Datei 822 KB
|=| BWStyler208Demo_gdbit.Bbf 22.01.201517:11 8BF-Datei 1252 KB
E Coloriage_64.8be 24.01.2014 10:27 8BE-Datei 245 KB
E COLORProjectsd PH7_x64.8be 23.06.2015 23:01 8BE-Datei 221 KB

items =

Lo Computer

7. Restart your Photoshop application and open an image.

8. Navigate to File & Export - ANALOG projects 3... . One click will
start the plug-in.
The image will now be opened in ANALOG projects 3.
The plug-in will not be in the Filter menu.
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File Edit Image Layer Type Select Filter 3D View Window Help

Ctrl+M

Mew...
m Controls

[:]pen Strg+[]
Browse in Bridge... Alt+Ctrl+ 0
Browse in Mini Eridge...

Open As... Alt+Shift+Ctrl+ 0O

He A HWNAY NRG DO

Open as 5mart Object...
Open Recent

9

Close Ctrl+W
Close All Alt+Ctrl+W
Close and Go to Bridge... Shift+ Cerl+W
Ctrl+5
Shift+ Ctrl+5

[

9

Save
Save As...
Check In...
Save for Web...
Revert

b

9

Alt+Shift+ Ctrl+5

b

k

Place...

9

" Import
2 Share on Behance... AMNALOG projects 3...
= Automate b COLOR projects 4...
y Scripts b DEMOISE projects professional..
DEMNOISE projects standard...
4 File Info... Alt+Shift+ Ctrl+1 FoCus FIFEI_iECth F]FD'FEES-iEIFIE'...
a Pang - Cirl+P FOCUS projects professional...
[::'_v'r ) Print One Copy Alt+5Shift+ Ctrl+P HDR projects 2...
® . HOR projects 3 professional...
= Exit Ctr-Q HDR projects 3...
'__";‘ HOR projects 4 professional...
HDR projects 4...
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1.3.2 Windows 64 Bit Operating Systems

1. Complete the installation of ANALOG projects 3 by activating the
software.

2. For some reasons it may occur that plug-ins cannot be installed auto-
matically in all Adobe Photoshop®© versions. They have to be copied in-
to the plug-ins folder of Adobe Photoshop© manually.

3. Please close Adobe Photoshop®© as well as the stand-alone version of
ANALOG projects 3.

4. Open the installation package folder of ANALOG projects 3. Here,
you will find the plug-ins for all versions of Adobe applications that are
supported.

Home Share i Search Drive

&] \J Current folder - % Kind ~ | 47 Recent searches - | X
A R i ; 7 ’

= : subfolders ize * vanced options =

. 4, Al subfold L si Advanced opti “+

Computer o Date ; : z Openfile | Close
J Search again in * | modified = Q Other properties = ,,-_J Save search location search

Location Refine Options

T 0 WINANALOG projects 3_DE_EN_FR » v O "WIN AM...

El

Mame Date modified Type

| Photoshop CC 2014 Plugin 30.09.2015 12:42 Dateicrdner

| Photoshop CC 2015 Plugin ||

. Photoshop CC Plugin
| Photoshop €56 Plugin
| Photoshop Elements 11 Plugin

| Photoshop Elements 12 Plugin
. Photoshop Elements 13 Plugin
Photoshop Elernents 14 Plugin

30.09.2015 12:42
30.09.2015 12:42
30.09.2015 12:42
30.09.2015 12:42
30.09.2015 12:42
30.09.2015 12:42
30.09.2015 12:42

Dateicrdner
Dateiordner
Dateiordner
Dateicrdner
Dateicrdner
Dateiordner

Dateiordner

23.02.2015 17:47

170.964 KB

Ju
@ WIN AMALOG projects 3_DE_EN_FR_Setup.exe Anwendung

9 items B==
166 MB L= Computer

5. Open the plug-in folder of your Adobe application (in this instruction
the installation of the plug-in will be demonstrated for Adobe Pho-
toshop© CC 2015).
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6. Copy the file ANALOGProjects3_PH7_x64.8be from the installation
package and paste it into the plug-ins folder of Adobe Photoshop© CC
2015 that you will find here:

C:\Program Files\Adobe\Adobe Photoshop CC 2015\Plug-ins

RIiEFEN-|
Home Share View | Search | Drive | i ﬂ

%{ _Is Current folder | % Kind - | 45 Recent searches ~ I X I
' [ﬂl All subfolders _D= Size - Advanced options - ""&

Computer — Date Open file Close
Q Search again in * | modified = _D Other properties = | H Save search location | search |

|
Location ! Refine ! Options

T . » Adobe » AdobePhotoshop CC2015 » Plug-ins » v & "WIN AN, 2

o~

Mame Date modified Type

| Athentech 16.06.2015 14:25 Dateiordner
| Generator 16.06.2015 16:29 Dateiordner
| Google 16.06.2015 17216 Dateiordner
| Imagenaomic 16.06.2015 14:25 Dateiordner
| Panels 06.03.2015 1317 Dateiordner
. Redfield 07.09.2015 12:45 Dateiordner

T il o T o T e AL T R e e Ta G I B P Wa Y| Fa Tl WP W g4 Lo
3 =

i
i
i
A
A
i

| E AMALOGProjects3_PH7_x64.8be 11.02.2015 22:34 8BE-Datei 821 KB

W I 4= v ang g 4o e Fa T il TP W ol Tl P ]

|=| Autokye Demo_84.8bf 10.08.2011 13:17 8BF-Datei 745 KB
E BLACKWHITEProjects3_PH7_x64.8be 22.05.2014 15:39 BBE-Datei 821 KB
E BLACKWHITEProjects4 PHY_x64.8be 23.06.2015 23:01 3BE-Datei 822 KB
|=] BWStyler208Demo_g4bit.Bbf 22.01.201517:11 8BF-Datei 1252 KB
ﬂ Coloriage_64.8be 24.01.2014 10:27 8BE-Datei 645 KB
E COLORProjectsd_PH7_xb4.8be 23.06.2015 23:01 8BE-Datei 821 KB

itens =

18 Computer

7. Restart your Photoshop application and open an image.

8. Navigate to File = Export - ANALOG projects 3... .
One click will start the plug-in. The image will now be opened in
ANALOG projects 3.
The plug-in will not be in the Filter menu.

10
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File | Edit Layer Type Select Filter 3D View Window Help

Ctrl+M

Image

Mew...
m Controls

[:]pen Strg+[]
Browse in Bridge... Alt+Ctrl+ 0
Browse in Mini Bridge...

Open As... Alt+Shift+ Cerl+ O

Open as 5mart Object...
Open Recent

¥
n,
b

9

Crl+W
Close All Alt+Chrl+W
Close and Go to Bridge,.. Shift+ Ctrl+W
Ctrl+5
Shift+Ctrl+5

Close

b

b

Save
Save As...
Check In...

Save for Web... Alt+Shift+ Ctrl+ 5
Revert Fl12

9

b

k

Place...

b

J Import
2 Share on Behance... AMALOG projects 3...
2 At armate b COLOR projects 4...
’ Scripts b DEMOISE projects professional...
DEMNOISE projects standard...
- File Info... Alt+Shift+Ctrl+] FOCUS projects 3 professional...
a Pang - Ctrl+P FOCUS projects professicnal...
KM Print One Copy Alt+Shift+ Ctrl+P HDR projects 2...
® : HOR projects 3 professional...
2 = S HOR projects 3...
'__";“‘ HDR projects 4 professional...
HDR projects 4...

11
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1.3.3 MAC OS X Operating Systems

1.

Complete the installation of ANALOG projects 3 by activating the
software.

Open the installation package folder of ANALOG projects 3. Here,

you will find the plug-ins for all versions of Adobe applications that are

supported.

Please close Adobe Photoshop®© as well as the stand-alone version of

ANALOG projects 3.

Additionally, the latest plug-ins for your software are available at:
http://www.projects-software.com/plugins

Open the plug-in folder of your Adobe application (in this instruction
the installation of the plug-in will be demonstrated for Adobe Pho-
toshop®© CC 2015).

@ @ 7 MAC ANALOG projects 3_DE_EM_FR
= m o =~ 2 aQ
Favorites o
£3 Dropbox ‘-
= All My Files ANALOG projects 3 Phatoshop CC 2014 Photoshop CC 2015
¢ iCloud Drive Plugins Plugins
@)} AirDrop
=] Desktop
m Lektorat Photoshop CC Plugins Photoshop CS6 Plugins Photoshop Elements 11
Plugins
;.-'ﬁ-: Applications
@ Documents
t‘l bl Photoshop Elements 12 Photoshop Elements 13 Photoshop Elements 14
Shared Plugins Plugins Plugins
dubdpng

12
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[

[[m]]

7 Photoshop CC 2015 Plugins

=

]
oo

]

C, Search

)

Favorites

Q Dropbox
E Al My Files
¢’ iCloud Drive
@ AirDrop
[l Desktop
ﬁj Lektorat
#2: Applications
@ Documents

ANALOGProjects3_PH7.plu
gin

6. Copy the file ANALOGProjects3_PH7.plugin from the installation

package and paste it into the plug-ins folder of Adobe Photoshop© CC
2015 that you will find here:
Applications/Adobe Photoshop CC 2015/plug-ins

[ oN ] [ Plug-ins
— [»]
< HE - ERERECIR= © | #~ Q Search 7
Exeiinn ;5 ;’E_V‘::_’ Bl fA Adobe Phot...einstallieren L] ANALOGPr..._PH7.plugin
petinitie ol I8 Adobe Photoshop CS5 TIPS
% Dropbox ) Reminders {) AKVIS Refocus Plugin ] DENDISEPr..|_PHE.plugin
E Al My Files @ safari [ Beispiele » ] DENOISEPr..._PHG.plugin
A - @ R e [I9 Configuration > ﬂ DENOISEPr..._PH7 plugin
< iCloud Drive @ SILKYPIX D...Studio ProG B Legal + =] HDRProject..._PHE.plugin
@ airbrop g zLLVER projprofessional [ Locales » =] iCorrect Por..it 2.0.plugin
ype ~ oF
MATLAR > inCamera 4.5.plugin
B Desktop < Snapseed ﬂ Piccure.plugin
3} Lektorat @ Z:ftl\:varepasspnﬂ PrEe 8| Topaz_adjust5.plugin
ickies . o
lications [ seripting » ﬂ Topaz_BW2...fects.plugin
Ak H; SyEterr? Preferences [ skript-Dokumente » [l Piccure+ >
- otoZoom Pro 6.plugin rtSuite Plugin
51 Documents TextEdit Bhciaz som Pro'Gicl s At
AKVIS @ :"Le A:“:“"E % LegalNotices.pdf 0 AKVIS Chameleon Plugin
EE4 TinkerToo = Photoshop...itte lesen.pdf Q AKVIS Coloriage Plugin
Shared W/ Video Converter P'f) Q AKVIS Decorator Plugin
dubdpng & Wondershar...Pro fir Mac 0 AKVIS HDRFactory Plugin

hlehmann-pc

& Wondershare Vivideo
@ Mac Blu-ray Player

u AKVIS MultiBrush Plugin
ﬁ{-‘ AKVIS NatureArt Plugin

n-jspaeth10 _D e : 0 AKVIS Refocus Plugin
gl Bl Adobe Bridge CS5 1 AKVIS Sketeh Plugin =
[ n-trichter1 [Ell Adobe Bridge CS5.1 g &) AKVIS SmartMask Plugin
e fﬂ Adobe Creative Cloud > Ll 3D Engines [
Adobe Devi..Central CS5 » [ ADM »
[ nas1 (AFP) [ Adobe Dreamweaver CS5 » [ Alien Skin g
2] nas1 (CIFS) (2 Adobe Exte..anager CS5 » B Automate .
[&] Adobe Exte..nager CS5.5 » B cut out >
@ Al Adobe Fireworks CS5  » [ Digimare >
- [ Adobe Flas..atalyst CS5  » [ Effects >
Bl Adobe Flash CS5 L [ Extensions >
® Rot Adobe Illustrator S5 » B File Formats .
» Orange [l Adobe InDesign CS5 * [ Filters 4 ANALOGProjects3_PH7.plugin
-~ [l Adobe InDesign CS5.5  » [ Google >
s Bl Adobe MEdI‘.‘HCOdICSE 2 B Image Stacks > 174 KB
[ Import-Export > Created 12 Februar
ry 2015 at 14:16
® Blau Adobe PhotoshopCC2015» B Measurements g Modifled 12 February 2015 at 14:16
: = B Panels > Lastopened 12 February 2015 at 14:16
@ Lia i
Q Alien Skin . r PhotoZoom Pro 4.plugin Add Tags...
® Grau L‘] ArcSoft Connect Suite » PhotoZoom Pro 6.plugin
Yé Culout5.0 >
All Tags... B cutout 5.0 professicnal  » || 1l L

7. Restart your Photoshop application and open an image

8. Navigate to File > Export - ANALOG projects 3... . One click will
start the plug-in.
The image will now be opened in ANALOG projects 3.
You won’t find it as another filter.

13
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File Edit Image Layer Type Select Filter 3D View Window Help

Ctrl+M

Mew...
m Controls

Open Strg+ 0
Browse in Bridge... Alt+Ctrl+ 0
Browse in Mini Bridge...

Open As... Alt+Shift+Ctrl+ 0O

S A H WA DO

Open as 5mart Object...
Open Recent

#
&,
9

b

Cloze Ctrl+W
Cloze All Alt+ Ctrl+W
Close and Go to Bridge... Shift+ Ctrl+W
Ctrl+5
Shift+ Ctrl+5

b

b

Save
Save As...
Check In...
Save for Web...
Revert

b

b

Alt+Shift+ Ctrl+5

9

b

Place...

9

" Import
it Share on Behance.., AMNALOG projects 3...
z Antomate b COLOR projects 4...
’ Scripts b DEMOISE projects professional..
DEMOISE projects standard...
4 File Info... Alt+Shift+ Ctrl+1 FoCus FIFEI_iECth F]FD'FEES-iEIFIE'...
a T Ctrl-+P FOCUS projects professicnal...
K3  Print One Copy Alt+Shift+ Ctrl+P HDR projects 2...
® : HDR projects 3 professional...
- 2 Sk HDR projects 3...
'__"i:‘ HDR projects 4 professional...
HDR projects 4...

14
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1.3.4 Adobe Lightroom Interface with ANALOG projects 3
Windows Operating Systems

1. Open Adobe Lightroom.

2. Open Edit/Preferences/External Editing/ZAdditional External Ed-
itor.

3. In Additional External Editor choose the application ANALOG pro-
jects 3.exe

General I Presetz | External Editing |File Handling | Interface I Lightroom mobi|e|
Edit in Adobe Photoshop CC 2015

&-bit files are smaller and more compatible with variows programs and
pheg-ins, but will not preserve fine tonzl detail as well a5 16-bit data,
The sRGE color space cannot encompass the full range of colors
Color Space: |SRGB awailzable within Lightroom,

File Format: | TIFF

Bit Depth: |8 bits fcomponent

Resolution: | 300

Compression: |'.r_'IP

Additional External Editor

Preset: |Custom W |

Application: AMALOG projects 3.exe | Cheoss | | Clear |

: : JPEG files support onhy 8-bit, 8-bit files are smaller and mone compatible
File Format: | JPEG — with various programs and plug-ins, but will mot preserve fine tonal
detail as well as 16-bit data, The sRGE color space cannot encompass
Color Space: |SRGB " | the full range of colors awailable within Lightroom,

Bit Depth: |B bits fcomponent v|

Resolution: | 300 |

Stack With Original
Stack With Criginal

Edit Externzlly File Naming: IMG_D002-Bearbeitet, pad

Template: |C.ustom Settings

Cuskam Texk: Stark Mumber:

Restart Lightroom

15
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4. Click OK.

5. Right-click on a picture in Adobe Lightroom.

6. Choose Edit In > Edit in ANALOG projects 3.exe...

Lightroom Catalog-2 - Adobe Photo

File Edit Develop Photo Settings Tools

e |

=
[
S

5ol

View Window Help

Settings
Lock to Second Monitor

Show in Explorer
Go to Folder in Library

Go to Collection

Edit In
Phote Merge

Set Flag
Set Rating
Set Color Label

Add Shortcut Keyword
Add to Quick Collection

Stacking
Create Virtual Copy

Metadata Presets
Transform

Metadata
Export

Email Photo...
Remove Photo...

Background Options

—

Edit in Adobe Photoshop CC 2015...
Edit in ANALOG projects 3.exe...

&'
o»
&

Fusion Express 2 (84 bit)
Fusion Express 2 (32 bit)
Mystical

Open as Smart Object in Photoshop...
Merge to Pancrama in Photoshep...
Merge to HDR Pro in Photoshop...

Open as Layers in Photoshop...

7. If you still cannot find ANALOG projects 3 in the “Edit In” list please
check if the ANALOG projects 3 application is definitely set as exter-

nal editor and restart Adobe Lightroom.

16
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MAC OS X

1. Open your Adobe Lightroom Application.
2. Open Preferences/External Editing.

3. Navigate to section Additional External Editor in the middle of the
window. There is no application specified as default setting.

4. Click on Choose in order to open the application folder of your MAC
and to set your external editor.

@ Preferences

General Presats | File Handling Interface Lightroom mobile

Edit in Adabe Photoshop C55

File Format: = TIFF a 16-bit PraPhoto RGE is the recommended choice for best preserving
1 color details from Lightroom.
Color Space: | ProPhoto RGB <]
Bit Depth: | 16 bits/component ﬁ
Resolution: | 240
Compression: | ZIP a
Additional Extarnal Editor
Preset: | Custom _ﬂ

Application: < not specified >
!I|E Format: | JPEG

Color Space: | sRGE

oo " e T e SITaIeT ared T
compatible with various programs and pleg-ins, but will not preserve
fine tonal detail as well as 16-bit data. The sRGE color space cannot
encompass the full range of colors available within Lightroom.

Cok

Bit Depth: | 8 bits/componant

Resolution: | 240

Stack With Griginal

Stack With Original

Edit Externally Fila Maming: (MG_0002-Bearbeitet.pad

(5

Template: | Custom Settings

Custom Text: Start Mumber:

17
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5. Navigate to the ANALOG projects 3 application and click once to
highlight it. Confirm with Choose.

EO B = E EE. B8 Applications i+ t (| Q
Favorites & Automator
£2 Dropbox % Autopano Giga 2.6
5 [ BLACK WHITE projects 4
<2 iCloud Drive @ Blu-ray Player
] Desktop T calculator
& Ccalendar
m Eektdrat @ coMaster
43 Applications 4 Chess
[ clip Browser

@ Documents

5 COLOR projects 4
= akvis @ COLOR projects elements
@ COLOR proj...professional
il B Contacts
desktop-giGdvng ¥ CutOut5.0 L
dibaEng B cutOut 5.0 professional  »
- @& Dashboard
hlehmann-pc - . ANALOG proj
B Machan B Dictionary
%3 Dropbox
[ nas1 (AFP) & DVD Player
[ nas1 (CIFS) [ Evernote
B L= FaceTime ANALOG projects 3
onlinenas @ Firefox
@ Alle .. B Font Book
Font Browser _
b FontePro 2 Applicatior
® R Fz:lng % Promd Created Montag, 8. Dezember 2014 um 16:15
s 5 3 Modified Montag, B. Dezember 2014 um 16:15
Orange " AMELERIEE _ast opened Dienstag, 16. Februar 2016 um 10:00
@ GarageBand ersion 1.17
Gelb € Google Chrome Add Tags
Griin @ HDR 4.0 Darkroom

& HDR Darkroom
Cancel Choose
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6. ANALOG projects 3 has been set as external application now.

® Preferences

General  Presets [Sallu h=:lib=ll File Handling  Interface

Edit in Adabe Photoshop €55

16-bit PFroPhoto RGE is the recommended choice for best preserving
color details from Lightroom.

File Format: | TIFF

Color Space: | ProPhoto RGE

Bit Depth: | 16 bits/component

Resolution: |24 D-

. oow

Compression: | ZIP

Additional External Editor

Preset: | Custom
Application: ANALOG projects 3 _Choose || Clear
File Fermat: | JPEG EG files support only 8-bit. &-bit files are smaller and more

compatible with various programs and plug-ins, but will not preserve
fine tonal detsil as well as 16-bit data. The sRGE color space cannot

Color Space: | sRGE encompass the full range of colors available within Lightroom.

x.
=
Bit Depth: | 8 bitscomponent |

Resolution: 240

Stack With Griginal

Stack With Qriginal

Edit Externally File Maming: IMG_0002-Bearbeitet.pad

Template: | Custom Settings E

Custom Taxt: Start Mumber:

7. Close that window and restart Adobe Lightroom.

8. Open an image from your Adobe Lightroom catalogue. Click on the pic-
ture while holding down the CTRL key.
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F -:_ G S L "‘W y s -
A - ] - - - - F
Settings > \ e ™ f /
Lock to Second Window fage by T ' - /
‘. w‘ et . 4 o
Show in Finder B - ¢ A N . ‘
Go to Folder in Library : NPT S g a
Go to Collection > . o
Edit In > Edit in Adobe Photoshop CS5...
Edit in AMALOG projects 3...
Set Flag >
. Set Rating > Analog Efex Pro 2
3 - Set Color Label > Color Efex Pro 3.0 Complete
| Color Efex Pro 4
) Color Efex Pro 4
Stackmgl > Dfine 2
._ Create Virtual Copy Exposure 4
" Metadata Presets > Piccure+
Sharpener Pro 3: RAW Presharpener
Transform > Sharpener Pro 3: Output Sharpener
e - S!Iver Efex Pro 2
S . Silver Efex Pro
P Silver Efex Pro 2
Email Photo... Viveza 2
Viveza 2
Add to Quick Collection and Next {tB
Remove Photo... Open as Smart Object in Photoshop...
norama in Phi

—

- | ers in Photost
r e i
T . P \"' o ?_
. o * — T D L v h‘ ‘ m
L = L ol ~ P AW I i

9. Choose Edit In - Edit in ANALOG projects 3... and your photo will
be opened in ANALOG projects 3.
It will not be saved here: You can edit your image with ANALOG
projects 3 and then go back to Adobe Lightroom for more
adjustments without wasting too much disc space. When you finished
editing your picture you have to save the developed photo only one
time.

Background Options > R P iRhot

If you still cannot find ANALOG projects 3 in the “Edit In” list please
check if the ANALOG projects 3 application is definitely set as exter-
nal editor in the Preferences menu of Adobe Lightroom.
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2. Photos Done Quickly

You can obtain a finished image in just 4 clicks with ANALOG projects 3:

1. Load Images
2. Post-Processing Preset Selection

3. Optimisation Assistant

4. Select Image Detail and Save

Mfartich » Offantliche Bilder » Reicpisitalder +

You can simply drag and drop your images onto the start screen

How to get the results you want, and fast - the elaborated presets and
looks, individual image adaption and selected drawing allow you to also go
the creative route. ANALOG projects 3 offers both options.

Alternatively, you can also use the toolbar buttons or drop-down file
menu.

File

. Start

Load image... Cirl+Shift+0

Image data browser...
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3. Optional: Image Preparation

Click on Extras/Preparing image... Here you can precisely configure
the image preparation settings or select the standard settings and turn off
the image preparation window which pops up upon uploading photos.

For the first steps, select the standard settings. Clicking the back arrow at
the bottom left restores any changes made here back to the standard set-
tings, so nothing is irreversible.

. . a. Colour space conversion: advanced

j [mage F”EP*‘.’_ i users can choose a colour space here
[ Colour space conversion - for all other users, it is recommend-
Adobe RGB Bl cd to not make any adjustments, to

avoid incorrect colour rendering later.

[F White balance

True to shot/camera

Candlelight b. White balance: corrects colour

;ﬁn"“;‘:t:'ﬁ;;‘:;ﬂ'jh casts that occur with shots taken, for

200-watt lightbulb example, in a warmly lit room. To

£ oaen latt start, leave this setting unchanged.
uorescent light
Maorning/evening sun

Late morning/early afternoon sun
Midday sun

c. The colour temperature ranges

Cloudy sky from 1000K to 16500K, which makes
;f‘feskﬂsha - for a powerful tool for establishing
Northern lights warm and cool moods.

1000K femperature — d. The checkbox at the bottom edge

_ of the window allows you to choose if

you would like to have this window
displayed when uploading images or
not.

‘) B Always shey. this window

e. The backwards arrow returns all adjustments back to their ini-
tial values.

f. Exit image editing and switch to post-processing mode using = this
arrow
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4. Post-Processing: Presets

>> Defauttsettings << S

All: 102 Custom
roll film: 12

polarisation: 10

wet plate: 13
Vintage: 12

Old newspaper: 7
Lomec =
camera obsoura: 6 freestyle: 12

& Favourites

Combine default settings
Import Export
-no filter -

Wet plate 1

Wet plate 2

Ty

A change from previous versions, we are
starting directly with post-processing after
uploading the images. Here we can control
the picture’s tone mapping and edit the re-
sults with filters and effects.

Left side of the post-processing screen:
the presets show the breakdown of the live
preview in categories with the quantity of
presets in the appropriate category:

“All”

“Wet Plate”
“vintage”
“Pocket Camera”
“Plastic Lens”
“Camera Obscura”
“Roll Film”
“Polarisation”
“Old Newspaper”
“Lomography”
“Freestyle”

To begin, we’ve chosen the “Wet plate 1”
preset. Clicking on the preview image
applies the effect to the image in real time,
which will then be displayed in the middle
of the screen. Discover the wide variety of
different looks by clicking on the 102
different presets. You will be amazed by the
intriguing styles in the artistic section!

All 102 ANALOG projects 3 presets at a single glance. The “Default
settings” section can be separated from the rest of the interface by
clicking on the "Default settings"” bar, which then allows you to adjust the
size of the window as preferred.
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Custom
roll film: 12

Combine default se

Import Export

-no filter -

% N

Wet plate 13 Roll film 1
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4.1 Comparison View i3

Do you want a comparison to the image without tone mapping? Simply
right click on the middle of the image to see the before/after result. A
quick check on the editing process is available at any time. For an exten-
sive overview with selectable areas and luminance display, click on the
symbol bar.

[ Compare Window

4.2 Real Time Processing

When activated, all of the changes that you have made to the preset set-
tings will be immediately applied to the image and you will see the out-
come of your adjustments directly.

4.3 High-Quality Display m

Activate this option to see the preview image in high-resolution. If the
preview is set at 100%, there will be no difference. If you zoom in on a
section of the photo however, there is a noticeable difference in quality.
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4.4 Combine Default Settings

To merge two looks together use the “Combine default presets” button
directly under the categories. These new presets will be saved under "Cus-
tom"”. It’s that easy to expand your numerous options and accumulate
new ideas!

4.5 Import/Export from Presets

Presets from earlier versions can be easily imported. Do you want to ex-
change all of your presets with a friend or just secure all of your treas-
ures? Use the practical export function.

Import Export

-no filter -
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4.6 Name Favourites

Have you found certain presets that you
love and instantly want to have handy?
Click on the top right star in the preset
window and add the setting to your fa- Import Export
vourites. By clicking the button, pre-
views all of your favourite presets will be displayed.

“ Favourites

Combine default settings

;>> -DE%ault seﬂir;gs <<
I

Custom

Combine default settings
Import Export

Wet plate 1 Wet plate 2 Wet plate 3 Wet plate 4

Wet plate 6

> Filter Presets

Locating presets can be difficult when you have imported presets or creat-
ed many additional looks. For example, enter “vintage" into the search bar
and only presets relating to “vintage” will be shown.
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4.7 Select a Preset

After loading an image, we now see the photo with its effects as a Real
Time Preview in the middle, and the Presets (image suggestions) in the
bar on the left.

We are currently in the Lomography category, the second preset from
the top and outlined in green. The presets are divided into 10 categories
to make them easy to find. Switch categories and click on Pocket
Camera. Now you can browse through the range of previewed examples
from the top category and look at them in the Real Time Preview. Take
your time to click through the list and take in the fascinating possibilities!

28



ANALOG projects 3 — User Manual

4.8 Presets and Origins for the Categories

Wet Plate: The look for this category is adapted from the beginnings of
photography. Glass plates were coated with collodion and treated with sil-
ver nitrate. Still damp, these plates were then used in field cameras. The
plate would have to be developed immediately following exposure, which
meant that photographers always had to have a darkroom with them.
These various presets imitate diverse chemical processes and substrates
used for wet plates. Experimenting is emphatically encouraged!

Vintage: Here you can find classic, retro and up to the minute styles for
all presentational purposes. These days, the emotionally charged photo
styles from the 50’s through 80’s have a major influence on online retail-
ers, websites and blogs. And we know that you want to try out everything
that can be done with a smartphone on your big PC screen even more!
Get inspired and create your own hip vintage style.

Pocket Camera: Don’t be afraid of leaked light, colour deviation or lens
flares. These presets are based on cameras from the 60’s and 70’s, like
the legendary Kodak Instamatic and Agfamatic cameras. Technically “cor-
rect” is something different; here you can combine all of the available
tools as you fancy - this is pure emotion. Here is an example of a lovely
portrait that just needs that last finishing touch:

r

Feckatkamera7 Focket Kamera 8 Focket kameras
* * -
7 : 7 % 7 %
t L] @ 6 @
M
= -
x B~ | r 3
P — ST P ——
* * *
( 5 (f G ) T
3 ® @ ®
~
p et 3
*
a
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Portrait Shots: Filters 2 and 10 from the “Pocket Camera” category make
the photo brighter, friendlier and more emotionally appealing.

Plastic Lens: The hot “trash” look from Holga plastic lenses is simply op-
timal for soft portraits and gentle landscapes. Since the lenses are often
misaligned, the edges end up blurry, which has its own charm and brings
the focus to subject in the centre. If you are looking for sharpness through
and through, you might want to pick a different category.

Camera Obscura: Over more than 2000 years ago, Aristotle discovered
the phenomena of the “camera obscura”. Camera obscura essentially
means “dark room”. In a darkroom, Aristotle observed that an image was
inverted when projected through a small hole onto an opposing surface.
And that’s how he discovered the fundamental idea of photography.

Tip: If you are interested in using some of this category’s features, but
would rather not turn your image upside down, just click on the “Projec-
tion” option in the filter to turn the mirroring off.

Roll Film: Rollfilm was the film used for decades by high end cameras like
Hasselblad, Mamiya 6x7 and Rolleiflex 6006. When it comes to shooting in
analogue style today, rollfilm is still prefered. Even here, you aren’t safe
from light leaks in the developing tank. Once fully processed, frame your
photos with professional filmstrips - there’s lots to choose from.

Polarisation: In the 70’s, everyone wanted to immediately have prints in
their hands, and thus the popularity of the Polaroid camera. In the begin-
ning, this technology required development times of different lengths,
which lead to photos with a prominent tint. Similarly, the base substrate
and coating lead to a mild 3D effect, which is recreated in the various pre-
sets. The Polaroid movement never really came to an end; after fine-
tuning of Polaroid film production in 2008, other companies continued to
produce the devices, and there are even new Polaroid cameras on the
market today.

Old Newspaper: Here you’ll find must-have presets like coarse resolu-
tion, paper structure, sepia tones and blotches.

30



ANALOG projects 3 — User Manual

Lomography: “Lomo” is the name of a simple plastic camera which
caused an entire photography movement. The images shot with this cam-
era or similar ones are characterised by technical errors, poor resolution
and blurriness. The results are difficult to predict, which is exactly the
charm. In an age of perfect digital cameras, the element of surprise and
the excitement around how an image will turn out can be quickly missed.
Discover a completely new philosophy of photography and riffle through
the Lomo presets. You can tell right away that our developers have fun
making these!

Freestyle: Everything is allowed in this category! Lots of freely inspired

styles of all sorts. Find out what works best for your photo or create your
very own crazy style!
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5. Post-Processing: Finalise

Now that we have understood the most
important part of post-processing, let’'s finalice
go onto fine-tuning, which can be found
on the right side of the screen under
“Finalise"”. These features are intended to only to be used to edit pictures
further after selecting a preset.

5.1 Intelligent Colour Space (SCA Processing)

This menu offers you options for optimal colour detail gradation of your
tone mapping results. Selecting SCA processing (Smart Colourspace Adap-
tation) demonstrates differences in the details of more saturated colours.

Intelligent colour space (SCA method)

Colour median (balanced)

Tip: With “Supersampling” you will get exceptional details and saturated
colours!
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5.2 ANALOG projects 3’s film emulation engine

ANALOG projects 3 includes film Photo film emulation
looks fr_om the Iegend_ary_days of ana- & digital negative
logue film, thanks to its film emulation

engine.
Rummage through a box of old photos - it's worth it! Select a type of film
and its specific colour characteristics, such as grain and contrast film ef-
fects, to apply to your picture. You can regulate the intensity of individual
features as well as the overall effect of a film look.

“Photo Film Emulation” can be found on the ride side of the screen un-
der “Finalise”. What would analogue photography be without the magic
of different types of film?

ANALOG projects 3 offers you a complete emulation engine with colour
film, diafilm, and black & white film - which you definitely have to try out!
You are on the hunt for authentic looks with all of the strengths, weak-
nesses and emotions from back in the day? You’ve come to the right spot.
In this case, grain is desired as a creative tool and can be separately ad-
justed for each type of film. Give the various films a try and discover new,
unique characteristics.

Agfa Futura: All-round film with a wide exposure scope, and forgives an
occasional faulty exposure. This camera isn’t best known for sharpness
but is therefore well suited to portraits.

Fuji: Enhances the yellow and green elements of the image, and is the
first choice to give lomography shots that last finishing touch.

Fujichrome: This film was originally introduced for fashion and product
photography. Works excellently with the rollfilm presets.

Kodak: Everyone knows the unmistakable look of the Kodak Ektachrom
64, which made its mark with fine grain, lush colour rendering and out-
standing brilliance. It is the film for eternity. 30 years of storage is noth-
ing for this medium, which means that it is again and again the film of
choice for image archives. Even private dia-collections are kept notably
well with this film.

Efke: Black & White film from Efke is distinguished by rich grayscale re-
production and great sharpness. Since the manufacturing process hasn’t
changed in 50 years, it can’t compete with modern film in regard to grain.
This film characterises the black & white look of the 50’s and is as modern
today as ever before.
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IIford: Generations of photographers have used lliford film, and simply
belong to the digital darkroom. The legendary Pan F with its ISO 50 is one
of the sharpest films and has been used for architecture, still life and fine
art prints for eons. In the other corner is the beloved HP5, the film for
photo journalists, who also have to document at night. The film is moder-
ately gritty, however works for exposures up to 1ISO 3200 and is a jack of
all trades.

Kodak T-Max: The T-Max 3200 was the film of choice for night photog-
raphy or available light situations, however you had to be careful of the
quickly appearing grain. Today’s generation of T-Max is fine grained in
comparison and literally a dream for shots with little light.

Tip: If you want to quickly convert a colour image into black & white, go
ahead and select a colour preset. You can select a black & white version at
the end in Film Emulation. It’'s that easy!

5.3 Post-processing Effects and Selective Application

ANALOG projects 3 has 59 expert filters that you can discover one after
the other. We would like to show you a few that are near to our hearts,
and that you can apply for dramatic results.

To find the filters, type the name into the search bar above post-
processing effects. ANALOG projects 3 will find it quickly for you!

Form vignette: Imitates the vignetting effects of older lenses and is an
important stylistic device for vintage looks.

Image Toning: The tool of choice to add colour casts to an image. Give
selective editing a try and limit the toning to one area of the image.

Structure - lights, paper, dust & spots, stone: You have landed in a
designer’s playground. With the Structure - lights effect for example, you
can establish a completely new atmosphere with just a single click - a feat
which would require laborious levels and masks with other photo editing
software. Dust and spots, paper and stone structure filters top off your
creative possibilities. If you like it, it’s allowed! Select the effects in the
texture browser and try them out - it brings life to life!

34



ANALOG projects 3 — User Manual

Bokeh Blurring: Everything sharp? In [k

professional photography, larger areas normal ¥ Opscty 100% o
are often not sharp on purpose, in order
to direct the focal point. These unsharp
sections are called “bokeh” and are just
as crucial as investing in sharp lenses.
Emulate the silky-softness of bokeh
produced by the most expensive lenses.
Just quickly mark a selection and the

main motive is set in a magnificent : Angle 0
scene. Activate the “Bokeh blurring”

filter by double clicking. The effect will whestl Lights 50

now be applied to the entire image,

however we want the central focus to Saturation 0
remain sharp.

Precision 50

For that we switch to selective mode, found at the top left of the Effects
window.

Bokeh blurring

Edge defintior

oo o@mAa o

Select the area that is to be excluded with the red circle and set the
square on the main subject. We can now close the window - and done!
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Soft contrast: Use this method to quickly generate movement effects -
the weapon of choice to liven up static images.

Dynamic brightness: This new feature from ANALOG projects 3 adds a
specifically set glimmer of light and makes every image into a fascinating
eye catcher.

Aura: Soft light in the background can help to steer attention towards the
main subject and be applied in many different ways.

Exposure Errors: This filter is especially trendy for the Lomography and
Pocket Camera categories. Since cameras back then often weren’t com-
pletely light-tight, the film had stripes from light leaks. Browse through
the texture library to see everything there is to try. You are sure to find
gold.

. Select effect texture ﬂ

The Effect Texture Browser contains various light effects for styling your
images. You can also combine multiple effects by simply selecting the
“Exposure Error” option a second time.

Glamour lighting: This effect filter is especially irresistible for portraits.

Frames and Film Frames: With ANALOG projects 3, you can simply
produce subtle frames yourself or select a film frame from the library.
Makes for an exquisite finishing touch.
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Tip - creating your own looks: Apply a preset containing the post-
processing effects you consider to be the most important, deactivate all
the filters by clicking on the checkmarks and save the file. Upon loading a
new image, you can process all of your applied effects from top to bottom
and quickly develop your own style.

5.4 Optimisation Assistant

The optimisation assistant is a very Optimisation assistant
efficient tool for fast, fascinating re- @ | Oplsaton o Opbmizaiion off

sults. When the preset is activated,
denoising, tonal value, clarity, dynam-
ic and sharpness settings can all be
adjusted by sliding the control to the
left or right. The result can be seen

live. P Tonal value

. D - ==
e | ENaISIng

The optimisation assistant is intelli-
gent; it remembers the values you en-
tered, and applies the same settings
to the next image in the same way,
but tuning the result to the new motif.

If you would like to edit without the
assistant, you can simply turn it off. If
you would like to turn off the values
that have been “learned” so far, click

on the

X Color
e HSL ilumination -

Intensity 0 strong

wezk

Colour toning
< @) 4 & @

Colour tone

Saturation 50

Orpacity 50
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5.5 Scratch and Sensor Errors

Corrections

Micro-contrast enhancement used in photography unfortunately shows
every unwanted sensor imperfection that every photographer, despite
internal camera sensor cleaning, knows and dreads. Don’t stress - just
eliminate them! With the easy to apply correction function from ANALOG
projects 3, it can even be fun.

Pro Tip: This intelligent correction doesn’t only remove sensor spots, but
other disturbing things too - a deserted beach has never been so easy to
produce.

Lightly mark defects in your motif, the program will automatically substi-
tute these areas with other appropriate parts of the image.

Here’s how to go about correcting:

Select the brush tool under (6) and click
on the point of the image that you would
like to correct. A circle will appear beside
it that will serve as a source.

Move this circle to a place on the image
that can act as a source for the first

marking. The selected area will then be o® &=
improved based on the source. & "’g(

Prior to this, you can reveal sensor spots, Correction areas (0/200)
which will appear as a bright patch in the _
image, with (1). ' - £=3

(2) Allows you to expose or hide the
fixed areas even when the corrections are
still active, even if they have been blend-
ed in. Hiding is solely to enable a before

Selected area
and after comparison. =

You can select multiple areas to correct
by simply clicking on the brush symbol

(6) and adding another point. E} - ﬁl.".‘
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The button marked (3) can blend the targeted corrections in and out,
which also controls clarity.

(5) Deletes the added corrections.

The section marked (7) controls the size of the area that is to be correct-
ed.

You also have the option to automatically search for the best source area
for the improvement. Click on the (8) button.

Button (4) calculates the appropriate correction spots for all of the points
automatically set using (8).

All currently selected corrections can be deleted with the (9) button.

= e

Tha S

The sensor spots are circled in red
The sensor spot corrector marks all of the patches and determines a
source within the image that can be used as a substitute.
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5.6 Custom Presets

One thing is certain, regardless of which settings you have changed, if you
have applied additional filters or adjusted a filter’s settings, the selected
preset has been modified and to the right of the preview image is the fol-
lowing symbol:

X Color

e HSL illumination

Clicking will reset the preset back to its initial state.
Careful: All of the modifications applied up to this point will be undone!
Clicking saves all of the changes in a new preset. A dialog box will

open where you can enter a new name for your preset or confirm the sug-
gested one. The system will name it “Copy”.

Copy default setting

Enter name:

4 (Copy))

The preset will be saved and moved to the “Custom™ presets category.
The new preset has been additionally generated and the starting preset is
preserved. You can also never overwrite a default preset!
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6. Workflow

6.1 Edit final image further in an external program

ANALOG projects 3 offers interaction with external programs. That way
you can take a successful image result to another photo editing program
and continue there.

6.1.1 Open in other projects programs

Click on the “Projects” symbol in the toolbar
to open the image in a different program
from the projects series. Use the drop-down
menu beside the symbol to choose one of the programs that you already
have installed on your computer.

L] sHarpeN projects professional w
PROJECTS

6.1.2 Open in other photo-editing programs

BdaE B O

2l

To directly open the image in another photo
editing program, such as Adobe Photoshop,
click on the corresponding button in the

External image processing symbol bar

Photoshop CS6/CC

Lightroom 4/5

Photoshop Elements 11712

If necessary, go through the settings to Extras Add-ons
show the path to the program. Click on
“Extras” in the menu and select “Set-

tings” in the drop-down menu: _ T

Batch processing Ctrl+B

Settings

Create restore point  Shift+Z

Timeline Ctrl=T

Next, click on the “Export” tab. You can enter the name of a photo editing
program here, and save it for later as well.
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5

Program Export Calculation Save formats

External programs

Export formats: TIFF 16-Bit (*.tiff) = wported files under the original path

File-Prefix: File-Suffix: AMALOG projects - File name_ANALOG projects.tiff

% External image processing
B Photoshop CS6/CC
0 Lightroom 4/5

B Photoshop Elements 1112

6.2 Work with a timeline and restore points

This option can be found in the symbol bar at the top edge
of the screen:

“Create Restore Point” saves an in-between point of the current set-
tings. You can now always return to this stage of your editing. You can
save as many editing restore points as you like. The timeline displays the
restore points and makes it possible to call up any phase with just a single
click:

Timeline - 6 Undo entries - 0.02 GB (378.88 GB available)

Wed Mar 2 2016 - 11:39:20 ‘Wed Mar 2 2016 - 11:39:27 Wed Mar 2 2016 - 11:39:34 Wed Mar 2 2016 - 11:39:52 Wed Mar 2 2016 - 11:40:00 Wed Mar 2 2016 - 11:40:24

o BB e B B

This function is especially useful when, for example, you are satisfied with
an image, yet want to continue trying out different settings and effects.

—] Simply set a restore point and carry on editing your picture. If you
L] . . . . h
want to go back, simply click on your restore point in the timeline.
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6.3 Selecting and Saving Sections of Images

the file menu or use the corresponding keyboard shortcut (Ctrl+S

To save a final image, click on the button in the toolbar, go through
or CMD+S with MAC).

» Cropping and captions

As soon as you have initiated to save a file, the cropping and caption win-
dow will open.

I
. Cropping &t Title

At the top are several practical aids for perfect image composition and
cropping.

You can set the aspect ratio and activate guidelines like the rule of thirds,
the golden section or the golden spiral.

The centre of the window shows your final image. Fix the area to be saved
by adjusting the corners and borders of the photo.
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At the bottom is an option to enter a caption. You can determine the size,
position and background for the text. The size of the text will be automati-
cally coordinated to the final cropping.

You can either crop free-handedly or use one of the provided formats.
As soon as the image has been cropped and captioned, confirm the save

and the following window will prompt you to select a file format and name
your file.
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6.4 RAW Processing m

You can upload and edit RAW image data with the integrated RAW mode.
Numerous tools are available to you here, such as denoising/sharpen,
exposure, colour, detail and powerful distortion capabilities.

T RAW processing -
T

+ White balance
+ Denuisingsharpness
+ Colour balance

& Expesure

+ Delail

+ Colour

+ Palette

& Distortion

& General

Interfering chromatic aberration can be easily removed in the
“colour” category

An overview of the most important RAW functions:

White balance:
Here you can regulate the colour temperature. Use the pipette to select a
white balancing colour directly from the image.

Denoising/sharpness:
This feature regulates the image’s noise and sharpness. Control the quali-
ty and different types of noise such as colour noise, banding or hot pixels.

Colour balance/white balance:

Here it’'s all about colour and black/white correction. Modify the general
colour mood and neutralise white and black - the icing on the cake for
professional colour correction.

45



ANALOG projects 3 — User Manual

Exposure:
Influence lights, shadows, contrast and brightness in the final image.

Detail:
Fine-tune clarity and micro-details with lights, shadows and midtones.

Colour:
These colour settings are all about the luminosity of lights and shadows.
You can even reduce the presence of unwanted chromatic aberrations.

Palate:
Adjust the saturation of individual colours.

Distortion:

Take a closer look. These
mighty tools can straighten ark Peripheral light 0
out the horizon, correct cam-
era angles and lens errors.
Use “Autofit” to automatically
trim any awkward borders

4 Distortion

Lens correction

Rotation 0

Vertical 0 Yaa

Horzontal 0 Yo

Foom 1000 e

MSIToW A5 F"E"d |:|

chift LR 0

Shift U-D 0 Yoo dowm

¥ Autofit
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General:
Activate the “360° panorama mode” to optimise matching edges of imag-
es in a panorama series.

Bovoneorose NN e

® Would you like to save the settings in the current camera profile?

[}

Save your settings as a camera profile to save time in the future. This can
be reset at any time.
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6.5 Batch Processing

Extras ANALOG projects 3 batch processing al-
EE Batch processing lows for automatic processing of multiple
bracketing series. The function can be
@ Preparing image... found in the drop-down menu for “Extras”

in the menu bar.
Fo Settings Ctrl+P

E_a Create restore point  Shift+Z

IEI Timeline Ctrl=T

Source file Results
Source directory: | Target directory:

% Indude all subdirectories Format: TIF 8-Bit (= tif)

File filter

File type: allimages File name filter:

Processing settings
Image preparation: <] Post-Processing: Wet plate 1

[ automatic image optimisation

Images

ct valid source and target directories
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Note: Remember that looking through folders with several subfolders can

require a lot of time. That’s why selecting “C:\* is not recommended.

» Results: Here you can set where the resulting images of the batch

processing will be saved. Select the corresponding folder with the
“Target directory (. . .)” button or enter the name of the folder di-
rectly into the text box.

Format: You can choose from five different formats to save your re-
sulting images. In form of .jpg and .tif, there are two 8 -bit formats
and two 16-bit formats, as well as one png format. JPG images are
always the highest quality and TIF files are saved uncompressed and
without defects.

Editing settings: Choose which filters of the batch you would like
to apply. From here you can also access image preparation and se-
lect presets to be administered to the image. If you would like to
later assemble the edited images into a 360° panorama, select pan-
orama mode to eliminate exposure and contrast edges in the indi-
vidual images.

6.6 Add-ons

Add-ons

With help from add-ons, you can not only " Importadd-on

import presets, but entire post-processing

modules can be integrated, which can be *— T e

necessary to create new preset looks.

.:,!'* I' Add-on information
u

1. Extract the files from the downloaded zip folder.
2. Open your ANALOG projects 3 version

3. Click on Menu 2> Add-ons =2 Import Add-on
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Support

If you have questions regarding the installation, problems or errors of the software,
please contact the FRANZIS customer support team.

Contact form: www.projects-software.com/contact

Please understand that your questions can only be answered directly by FRANZIS cus-
tomer support. This is to give us the opportunity to constantly enhance our customer
service for you and to make sure that you receive only the most qualified answers to all
of your questions as fast as possible.

This is how our customer support works best:
Please have the most important details about your computer and about our product at
hand when you call our customer support. These include:

e Name of the product

e Product ISBN (which you can find on the back of the packaging, above the easy
to spot barcode).

e  Operating system of your computer

e Technical details of your PC including all your peripheral devices

Copyright

Franzis Verlag GmbH has prepared this product with the greatest possible care. Please
read the following conditions:

All the programs, routines, controls, etc., contained in this data media or within this
download are protected by their respective authors or distributors as mentioned in the
respective programs. The purchaser of this data media or of this download is authorised
to use those programs, data or data groups that are not marked as shareware or public
domain for his/her own purposes within the provisions of their designated use. He/she is
authorised to use programs or parts of programs that are marked as shareware, freeware
or public domain within the restrictions given by the respective programs or parts of pro-
grams. A reproduction of programs with the intent of distributing data media containing
programs is forbidden. Franzis Verlag GmbH holds the copyright for the selection, ar-
rangement and disposition of the programs and data on these data media or these down-
loads.

The data and the programs in this data media or within this download have been checked
with the greatest possible care. Considering the large quantity of data and programs,
Franzis assumes no warranty for the correctness of the data and a flawless functioning of
the programs. Franzis Verlag GmbH and the respective distributors do not undertake nei-
ther warranty nor legal responsibility for the use of individual files and information with
respect to their economic viability or their fault-free operation for a particular purpose.
Additionally, there is no guarantee that all the included data, programs, icons, sounds
and other files are free to use. Therefore the publisher cannot be held liable for a possible
breach of third party copyrights or other rights.

Most product designations of hard- and software and company names and labels men-
tioned in this product are registered trademarks and should be treated as such. The
product designations used by the publisher are basically as the manufacturer describes
them.

© 2016 Franzis Verlag GmbH, Richard-Reitzner-Allee 2, 85540 Haar, Minchen
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